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CALIBRATION PROCEDURE

SCXI"-1102/B/C

For NI-DAQmx

This document contains information and instructions for calibrating the
National Instruments SCXI-1102/B/C signal conditioning module.
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Conventions

»

bold

italic

monospace

monospace italic

Software

The following conventions are used in this document:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Ttalic text in this font denotes text that is a placeholder for a word or value
that you must supply.

The SCXI-1102/B/C calibration procedure requires the NI-DAQmx driver.
NIrecommends using the latest driver that supports both your development
environment and the SCXI-1102/B/C. NI-DAQmx includes high-level
function calls to simplify the task of writing software to calibrate devices.
NI-DAQmx supports many programming languages, including LabVIEW,
LabWindows™/CVI™, C/C++, C#, and Visual Basic .NET.

SCXI-1102/B/C Calibration Procedure 2 ni.com



Documentation

The following documents are the primary references for writing your
calibration utility:

*  The NI-DAQmx Help includes information about creating applications
that use NI-DAQmx.

e The NI-DAQmx C Reference Help includes information about the
functions in NI-DAQmx.

*  The DAQ Getting Started guides include information about installing
and configuring NI-DAQmx devices.

You can access these documents by selecting
Start»All Programs»National Instruments»NI-DAQmx after installing
NI-DAQmx.

For more information about the SCXI-1102/B/C, refer to the
SCXI-1102/B/C User Manual. For information about installing and
configuring SCXI modules, refer to the SCXI Quick Start Guide.

Calibration Interval

Password

Calibrate the SCXI-1102/B/C at a regular interval as defined by the
measurement accuracy requirements of your application. NI recommends
that you perform a complete calibration at least once every year. You can
shorten this interval based on the accuracy requirements of your
application.

© National Instruments

The default password for password-protected operations is NI.
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Test Equipment

NI recommends that you use the equipment in Table 1 to calibrate the
SCXI-1102/B/C. If these instruments are not available, use the
requirements listed in Table 1 to select a suitable substitute.

Table 1. Test Equipment

Recommended
Equipment Model Requirements
Calibrator Fluke 5700A 50 ppm
DAQ Device NI 6281 16-bit minimum
DMM NI 4070 6 1/2 digit, 15 ppm
Terminal Block SCXI-1300 —

Test Conditions

Follow these guidelines to optimize the connections and the environment
during calibration:

SCXI-1102/B/C Calibration Procedure

Keep connections to the SCXI-1102/B/C as short as possible. Long
cables and wires can act as antennas, picking up extra noise and
thermal offsets that affect measurements.

Use shielded copper wire for all cable connections to the
SCXI-1102/B/C. Use twisted-pair wire to eliminate noise and thermal
offsets.

Maintain the ambient temperature between 18 °C and 28 °C.
Keep relative humidity below 80%.

Allow a warm-up time of at least 15 minutes for the SCXI-1102/B/C
and 30 minutes for the DAQ device to ensure that the measurement
circuitry is at a stable operating temperature.
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Calibration Process

Initial Setup

© National Instruments

The calibration process has the following steps:

1.
2.

Initial Setup—Configure the SCXI-1102/B/C for calibration.

Verification Procedure—Verify the existing operation of the
SCXI-1102/B/C. This step determines whether the SCXI-1102/B/C is
operating within its test limits.

Adjustment Procedure—Perform an external calibration that adjusts
the SCXI-1102/B/C calibration constants with respect to a known
voltage source.

Verifying Adjusted Values—Perform another verification to ensure
that the SCXI-1102/B/C is operating within its test limits after
adjustments.

Complete the following steps to configure the SCXI-1102/B/C for

calibration:

1. Make sure that all the appropriate driver and application software is
installed.

2. Make sure all components involved in the calibration procedure are
powered off.

3. Assemble the SCXI-1102/B/C, SCXI chassis, terminal blocks, and

DAQ device as shown in Figure 1. You must cable the SCXI-1102/B/C
directly to the DAQ device.

5 SCXI-1102/B/C Calibration Procedure



1 SCXI-1300 Terminal Block 7 TBX 50-Pin Terminal Block
2 SCXI-1102/B/C Module 8 Cable to DMM

3 SCXI Chassis 9 Cable to Calibrator

4 SCXI-1349 Cable Adapter 10 Calibrator

5 Shielded 68-Pin Cable 11 DMM

6 NB1 Cable (50-Pin Ribbon Cable) 12 DAQ Device

Figure 1. Calibration Connections

4. Power on the SCXI chassis and the external computer.

You must configure the hardware properly with Measurement &
Automation Explorer (MAX). Refer to the SCXI Quick Start Guide for
details about configuring the SCXT chassis.

E Note When you configure a device in MAX, the device is assigned a device identifier. In
this calibration document, the functions used for demonstrating the calibration process use
the device identifiers Devl for the DAQ device and SCIMod]I for the SCXI-1102/B/C.

SCXI-1102/B/C Calibration Procedure 6 ni.com



Verification Procedure

© National Instruments

The verification procedure determines how well the SCXI-1102/B/C is
meeting its test limits. You can use this information to select the
appropriate calibration interval for your application.

The SCXI-1102/B/C stores gain and offset calibration constants for each
gain setting per analog input channel. A complete verification of the inputs

involves measuring the accuracy at all possible gain settings on all channels
of the SCXI-1102/B/C.

To view the calibration VIs in LabVIEW, select Measurement
I/O»DAQmx - Data Acquisition>DAQmx Advanced»DAQmx
Calibration on the Functions palette. You can also use the Search button,
shown in Figure 2, to look for a specific VI.

Search Boe View ™ |

|"» Programming
*  Measurement Ij0
L DA - Daka Acguisition
L DaQmx Advanced
L D Calibration

1 Series Cal ¥ Series Cal - D34 Calibration

42 Calibration SCKI Calibration

w

Figure 2. DAQmx Calibration Palette and the Search Button
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Complete the following steps to verify the accuracy of each
SCXI-1102/B/C analog input channel:

Use the DAQmzx Self Calibrate VI to verify the DAQ device. This VI
measures the onboard reference voltage of the DAQ device and adjusts
the self-calibration constants to account for any errors caused by
short-term fluctuations in the operating environment.

1.

Note Throughout the verification procedure, refer to the function call parameters for the

LabVIEW input values.
LabVIEW Block Diagram NI-DAQmx Function Call
Call DAQmxSelfCal with the
o DGy Self i
device i c:ihrrnaxte.ii following parameter:

DAL

errar out
55|

Device_Name: "Devl"

Connect the calibrator output to pins Al- and Al+ for all channels.
Refer to the SCXI-1300/1301 Terminal Block Installation Guide for
connection instructions. If you are not using the recommended
SCXI-1300, refer to Table 8 for the front signal pin assignments of the
SCXI-1102/B/C. If the calibration signal source is floating, connect
Al - to the SCXI chassis ground using the ground lug available on the

SCXI terminal block.

Set the calibrator voltage to the desired test point indicated in

Tables 6 or 7.

Create a task using DAQmxCreateTask.

LabVIEW Block Diagram

NI-DAQmx Function Call

LabVIEW does not require
this step.

Call DAQmxCreateTask with the
following parameters:

taskName: "AIVerificationTask"

taskHandle: staskHandle

SCXI-1102/B/C Calibration Procedure
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5. Add a voltage channel using the DAQmx Create Virtual Channel VI.

LabVIEW Block Diagram

NI-DAQmx Function Call

rinirmur walue
[}

rnairnum value
* DAGmx Create
Yirtual Channel wi

physical channels 2 bask ot

= efror ouk

Al Voltage ™

Call DAQmxCreateAIVoltageChan with the
following parameters:

taskHandle: taskHandle

physicalChannel: "sc1Modl/aix"t
nameToAssignToChannel: "myVoltageChannel"
terminalConfig: DAQmx_Val_Cfg_Default
minVal: -10 V

maxVal: 10 V

units: DAQmx_Val_Volts

customScaleName: " "

fWhere X refers to the channel you are verifying.

6. Set the gain value to 1 or 100 using the DAQmx Channel Property

Node. You can

find the AI.Gain property by selecting Analog

Input»General Properties»Advanced»Gain. Use the gain setting
that corresponds to the current test point.

LabVIEW Block Diagram

NI-DAQmx Function Call

Property Node

bask in =3 mennenn ;a! =% DACMx Channel gm:w kask out
errarin == r =5 error auk
AT, Gain

4

Call DAQmxSetAIGain with the following
parameters:

taskHandle: taskHandle
Channel: " "

Data: (gain value for particular test
point) float64

© National Instruments
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7. Configure timing for the voltage acquisition using the DAQmx

Timing VI.
LabVIEW Block Diagram NI-DAQmx Function Call
Call DAQmxCEgSampClkTiming with the following
samples per channel parameters:
rake taskHandle: taskHandle
1000
[atstey g coun
Tirnirg. wi source:
task in == == bask out
rate: 1000.0
EFPar in 3 oo > error out
Samnple Clock activeEdge: DAQmx_val_Rising
sampleMode: DAQmx_Val_FiniteSamps
sampsPerChan: 1000
8. Commit the verification changes using the DAQmx Control Task VI.
LabVIEW Block Diagram NI-DAQmx Function Call
Call pAQmxTaskControl with the following
ackion
DAGM parameters:
Contro_l
Eask in o e T.w == kask ook taskHandle: taskHandle
BTN N 35 eoo] LAY booo = error ouk action: DAQmx_Val_ Task_Commit

9. For each new test point, use the Time Delay Express VI to account for
the settling time of the SCXI-1102/B/C. Refer to Table 2 for the
settling time of the SCXI-1102/B/C.

Table 2. Settling Time of the SCXI-1102/B/C

SCXI-1102

SCXI-1102B, SCXI-1102C

3 minutes (first test point)

1 minute (all other test points)

5 second

LabVIEW Block Diagram

Function Call

Delay Time (=)
v Time Delay

errarin ==

= error out

Call a sleep or wait function to suspend
execution for the necessary settling time listed
in Table 2.

SCXI-1102/B/C Calibration Procedure
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10. Acquire 1000 points of voltage data using the Analog 1D DBL 1Chan
NSamp instance of the DAQmx Read VL.

LabVIEW Block Diagram

NI-DAQmx Function Call

data
3

kaskin == =% bask ouk

errarin == =% error ok

Analog 10 DBL
1Chan Maanp

Call pAQmxReadAnalogF64 with the following
parameters:

taskHandle: taskHandle
numSampsPerChan: -1

timeout: 10.0

fillMode: DAQmx_Val_GroupByChannel
readArray: data

arraySizeInSamples: 1000
sampsPerChanRead: sread

reserved: NULL

11. Compute the mean of the 1000 voltage values that you acquired.

12. Compare the resulting average to the upper and lower limits listed in
Tables 6 or 7. If the result is between the upper and lower limits, the
SCXI-1102/B/C passes the test.

13. Clear the acquisition using the DAQmx Clear Task VI.

LabVIEW Block Diagram NI-DAQmx Function Call
DAQMX Clear Call DAQm.xClearTask with
] Task, i the following parameter:
taskin == A

errarin == ==

£
- %u taskHandle: taskHandle

14. Repeat steps 4 through 13 for the remaining channels.

15. Repeat steps 3 through 14 for all test points in Tables 6 or 7.

You have finished verifying the analog input accuracy of the

SCXI-1102/B/C.

© National Instruments
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Adjustment Procedure

The adjustment procedure adjusts the gain and offset calibration constants
on the SCXI-1102/B/C. Complete the Verification Procedure prior to the
adjustment procedure to determine the pre-calibration accuracy and
whether adjustments are necessary.

Complete the following steps to adjust the gain and offset of the

SCXI-1102/B/C:

1. Connect the calibrator output pins Al- and Al+ for all channels. Refer
to the SCXI1-1300/1301 Terminal Block Installation Guide for
connection instructions. If you are not using the recommended
SCXI-1300, refer to Table 8 for the front signal pin assignments of the
SCXI-1102/B/C. If the calibration signal source is floating, connect
Al- to the SCXI chassis ground using the ground lug available on the

SCXI terminal block.

2. Connect the DMM to CH 0+ and CH 0- (pin 3 and 4) on the rear
connector. Refer to Table 9 for the rear signal pin assignments of the

SCXI-1102/B/C.

@ Note You can access these pins using a 50-pin cable connected to an SCXI-1349.

3. Start an external calibration session using the DAQmx Initialize
External Calibration VI.

Note Throughout the adjustment procedure, refer to the function call parameters for the

LabVIEW input values.

LabVIEW Block Diagram

NI-DAQmx Function Call

device in DAGm Initialize

External Calibration, vi
£ SC1Mod] || =+ talhandle out

passwiord i
MI

=7 error ouk

Call DAQmxInitExtCal with the following
parameters:

deviceName: "SC1Modl"
password: "NI"

calHandle: scalHandle

SCXI-1102/B/C Calibration Procedure
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4. Set the SCXI-1102/B/C to a gain value of 1 or 100 using the DAQmx
Setup SCXIT Calibration VI.

LabVIEW Block Diagram

NI-DAQmx Function Call

phwsical channel

cahandle in =5 -

EFrOF N =3 ==

DACm:x Setup

SCxl Calibration, vi
=+ calhandle out

e = > EFFOF OUE

1102 =

Call DAQmxSetupl102Cal with the following
parameters:

calHandle: calHandle
channelNames: "sc1Modl/aix"t
gain: 1 or 100

fWhere X refers to the channel you are calibrating.

© National Instruments

5. Set the calibrator to the desired voltage for the gain value you set in the
previous step. Refer to Table 3 or 4 for appropriate voltage set points.

Table 3. SCXI-1102 Voltage Set Points

Gain Set Points (V)

1 -9 -6 -2 0 2 6 9
100 | -0.09 | -0.06 | -0.02 | 0.00 0.02 0.06 0.09
Table 4. SCXI-1102 B and SCXI-1102 C Voltage Set Points

Gain Set Points (V)
1 -9 -6 =3 0 3 6 9
100 | -0.09 | —-0.06 | -0.03 | 0.00 0.03 0.06 0.09

6. Wait for the settling time to elapse and then record the measured output
from the DMM. Refer to Table 5 for the settling time of the

SCXI-1102/B/C.

Table 5. Settling Time of the SCXI-1102/B/C

SCXI-1102

SCXI-1102B, SCXI-1102C

60 seconds

5 second

13
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7. Adjust the external calibration constants using the DAQmx Adjust
SCXIT Calibration VI.

LabVIEW Block Diagram

NI-DAQmx Function Call

reference voltage
3

measured output
[}
DaQmx Adjust SCXI
Calibration, wi

calhandle in = ;;T
o=
Brrorin == &50’“

1102 =

== calhandle out

#% error ouk

Call DAQmxAdjust1102Cal with the
following parameters:

calHandle: calHandle

refVoltage: (calibrator output
voltage) float64

measQutput: (voltage measured by
DMM) floaté64

8. Repeat steps 5 through 7 for the seven voltage test points at the current

gain value in Table 3 or 4.

9. Commit the calibration changes you made in the session using the
DAQmx Close External Calibration VI. The data is written to the
hardware in this step.

LabVIEW Block Diagram

NI-DAQmx Function Call

DaQmx Close External
Calibration, i

errar out

Call DAQmxCloseExtCal with the following
parameters:

calHandle: calHandle

action: DAQmx_Val_ Action_Commit

10. Repeat steps 3 through 9 for both gain values in Table 3.

11. Repeat steps 1 through 10 for the remaining channels.

You have finished adjusting the gain and offset of the SCXI-1102/B/C.

Verifying Adjusted Values

After calibrating the SCXI-1102/B/C, NI recommends that you verify the

analog input operation by repeating the steps listed in the Verification
Procedure to ensure that the SCXI-1102/B/C is operating within its test

limits.

Test Limits

Refer to the SCXI-1102/B/C User Manual for the specifications of the

SCXI-1102/B/C.

SCXI-1102/B/C Calibration Procedure
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Gain and Offset

Table 6 contains the test limits to use when verifying and adjusting the gain
and offset of the SCXI-1102 and SCXI-1102B. Table 7 contains the test
limits to use when verifying and adjusting the gain and offset of the
SCXI-1102C. If the SCXI-1102/B/C was calibrated within the last year, the
test point value should fall between the Lower Limit and Upper Limit

values found in Tables 6 or 7.

@ Note The values in Tables 6 and 7 do not include DAQ device errors.

Table 6. SCXI-1102 and SCXI-1102 B Test Limits

Gain Test Point (V) Upper Limit (V) Lower Limit (V)
1 9.800000 9.80345 9.79655
0.000000 0.001002 -0.001002
—9.800000 -9.79655 —9.80345
100 0.098000 0.098060 0.097940
0.000000 0.000030 —0.000030
—0.098000 -0.097940 —0.098060
Table 7. SCXI-1102 C Test Limits
Gain Test Point (V) Upper Limit (V) Lower Limit (V)
1 9.800000 9.80345 9.79655
0.000000 0.001002 -0.001002
-9.800000 -9.79655 —9.80345
100 0.098000 0.098060 0.097940
0.000000 0.000030 —0.000030
—0.098000 —-0.097940 —0.098060

SCXI-1102/B/C Front and Rear Panel Diagrams

© National Instruments

Table 8 shows the pin assignments for the SCXI-1102/B/C front panel
connector. Table 9 shows the pin assignments for the SCXI-1102/B/C rear
signal connector.

15
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Table 8. Front Signal Pin Assignments

Front Connector Diagram Pin Number Column A Column B Column C
32 CH GND AL O- AL O+
Column 31 NC Al 1- Al 1+
A B C 30 NC AL 2— AL 2+
|
32 o o o 29 NC Al 3 Al 3+
31 o o o
28 NC Al 4- Al 4+
30 o o o
9| o o o 27 NC Al 5 Al 5+
28 o le) [e) 26 NC Al 6— Al 6+
27 | o o o 25 NC Al 7- Al 7+
26 | c o o 24 CH GND AL 8- Al S+
25 o o o
23 NC AT 9- AL 9+
24 o o o
3|l o o o 22 NC AL 10~ Al 10+
2| o o o 21 NC Al11- Alll+
21 | o o © 20 NC Al 12— Al 12+
20 o o o
19 NC Al 13- Al 13+
19 o o o
180 o o 18 NC Al 14— Al 14+
17 ] o o o 17 NC Al 15— Al 15+
16| o o o 16 CH GND Al 16— Al 16+
15 o o o
15 NC AL 17— Al 17+
14 o o o
B3] o o o 14 NC Al 18- Al 18+
12 o o o 13 NC Al 19— Al 19+
11} o o o 12 NC Al 20- Al 20+
10| ° o o 1 NC Al 21— Al 21+
9 o o o
10 NC Al 22— Al 22+
8 o o o
7l o o o 9 NC Al 23— Al 23+
6| o o o 8 NC Al 24— Al 24+
5]1©° ©° © 7 NC Al 25— Al 25+
4 o o o
6 NC Al 26— Al 26+
3 o o o
>l o o o 5 CH GND Al 27— Al 27+
1 o o o 4 CJ SENSOR Al 28— Al 28+
— |
3 CJ SENSOR AL 29— Al 29+
NC—No Connection 2 CH GND AT 30— AT 30+
1 +5V Al31- Al 31+
SCXI-1102/B/C Calibration Procedure 16 ni.com



Table 9. Rear Signal Pin Assignments

Rear Connector
Diagram Signal Name Pin Number Pin Number Signal Name
AI GND 1 2 AI GND
CH 0+ 3 4 CH 0-
NC 5 6 NC
112 NC 7 8 NC
3|4 NC 9 10 NC
5|6
718 NC 11 12 NC
9|10 NC 13 14 NC
11]12
1314 NC 15 16 NC
15|16 NC 17 18 NC
17118 OUT REF 19 20 NC
1920
21|22 NC 21 22 NC
23|24 NC 23 24 D GND
25|26
27| 28 SER DAT IN 25 26 SER DAT OUT
29|30 DAQ D*/A 27 28 NC
31132
k
33| 34 SLOT 0 SEL 29 30 NC
35| 36 D GND 31 32 NC
7
3738 NC 33 34 NC
39|40
41| 42 NC 35 36 AI HOLD COMP, Al HOLD
43|44 SER CLK 37 38 NC
45 | 46
47 | 48 NC 39 40 NC
49 | 50 NC 41 42 NC
NC—No RSVD 43 44 NC
Connection NC 45 46 RSVD
RSVD—Reserved NC 47 48 NC
NC 49 50 NC
© National Instruments 17 SCXI-1102/B/C Calibration Procedure



World Wide Support and Services

The National Instruments website is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

Visit ni.com/services for NI Factory Installation Services, repairs,
extended warranty, and other services.

Visit ni.com/register to register your National Instruments product.
Product registration facilitates technical support and ensures that you
receive important information updates from NI.

National Instruments corporate headquarters is located at 11500 North
Mopac Expressway, Austin, Texas, 78759-3504. National Instruments also
has offices located around the world. For telephone support in the United
States, create your service request at ni . com/support or dial

1 866 ASK MYNI (275 6964). For telephone support outside the United
States, visit the Worldwide Offices section of ni.com/niglobal to access
the branch office websites, which provide up-to-date contact information,
support phone numbers, email addresses, and current events.

Refer to the N/ Trademarks and Logo Guidelines at ni . com/ trademarks for more information on National Instruments trademarks. Other product and company names
mentioned herein are trademarks or trade names of their respective companies. For patents covering National Instruments products/technology, refer to the appropriate
location: Help»Patents in your software, the patents . txt file on your media, or the National Instruments Patents Notice at ni . com/patents. You can find
information about end-user license agreements (EULAs) and third-party legal notices in the readme file for your NI product. Refer to the Export Compliance Information at
ni.com/legal/export-compliance for the National Instruments global trade compliance policy and how to obtain relevant HTS codes, ECCNs, and other
import/export data. NI MAKES NO EXPRESS OR IMPLIED WARRANTIES AS TO THE ACCURACY OF THE INFORMATION CONTAINED HEREIN AND SHALL NOT BE LIABLE
FOR ANY ERRORS. U.S. Government Customers: The data contained in this manual was developed at private expense and is subject to the applicable limited rights and
restricted data rights as set forth in FAR 52.227-14, DFAR 252.227-7014, and DFAR 252.227-7015.

© 2000-2015 National Instruments. All rights reserved. 370029C-01 Mar15
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